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Part 1: Getting started 
 

This course 
This course is an introduction to Novapoint 21.  
 
The focus of this course is: 
 

 Become familiar with the user interface and working methods in Novapoint Base 
 Import map data from files 
 Build and edit terrain surface 
 Construct 3D objects in the model 
 Generate longitudinal-sections and cross-sections 
 Build sub surface layers 
 Become familiar with the use of windows, drawing rules, selecting objects, processes, 

etc. 
 

Course files 
The set of data to be used for this course is available in C:\Novapoint Base_Beginners course 
 
You will find the following files in this directory: 
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Terms and User Interface 
On Start up the screen will normally appear as below.  
 

 
 
The various  windows can be turned on and off or placed differentely. Click on the View tab, 
and you will se the different panes: 
 

 
 
At the first startup of Novapoint 21, the panes are enabled as shown above. The user can 
control which of them are active and where they are placed on the screen. The location of the 
windows is stored in the active binder, so that when you close, and open the binder again, the 
program will remember where you placed the windows. 
 
It is recommeded that you have the panes for Explorer, Process Info, Properties and 
Presentation Setup active. 
 
As an example select the Properties window. 
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To move the panes, hold down the left mouse button whilst you drag the window, and the 
possible locations to move the window will be highlighted. Drag the window to the desired 
location and release. 
 
 
Binder 
A binder is a file that keeps track of your project information (see project binders). In the same 
binder, you may add one or more Quadri models. The Quadri-model contains 99.9% of the 
information handled, whilst the binders contain information on, for example, which Quadri 
model is active (only one at a time) and which windows were most recently displayed. 
 
 
Explorer 
The Explorer displays the contents of a Binder. As mentioned above, these primarily contain 
one or several Quadri-models. You can explore the contents of each model, where you can 
become familiar with the process tree and the object, which are often presented as a tree. 
 
A model is made up of: 
 

•  Process Tree (tasks in a hierarchy) 

•  Objects, listed according to their object type 
 
 
Task 
A Task is just what it sounds like; something to be executed in order to complete the project. 
The tasks can be broken down into a hierarchy (Work Breakdown Structure, "WBS") to keep 
track of all the tasks. 
 
A task is given a name and a place in the task hierarchy. 
 
Each task is of a certain type. For each task type, there is a tool used to perform such task. The 
task type ‘Alignment’, for example, is performed by the Alignment design tool. 
 
Each task stores information about which objects in the model that were used as input to the 
task, as well as which objects were created in the model as a result of the task being executed. 
There are some exceptions; tasks that do not necessarily have input data from the model (for 
example import tasks) and tasks that do not produce results in the form of objects (such as 
presentation tasks). 
 
A task can therefore produce anything from 0 to 1 or several thousand objects. 
 
NB! A task can be repeated until you are satisfied with the result. 
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Object 
An object in the Quadri model represents primarily a physical object in the model with its 
attributes (geometry is one of the attributes). 
 
One object in the Quadri model can also be an object without geometry, eg. an event 
(accident, animal collisions , etc.). The model also allows for physical object to exist in the 
model without geometry. 
 
The available objects in a model are defined in the object directory. Object types are 
categorized into object groups. An object in the model is an instance of an object type, as 
defined in the object directory. 
  
An object has at a minimum the following attributes: 
  

 Name (name of the instance of the object type) 
 Life-cycle status (existing or being designed) 
 Unique ID (generated by the program, attached to the object throughout its lifetime ) 
 Validity time period 
 Valid from time 
 Valid to time 
 Generic attribute 

 
All objects have the ability to have an unlimited number of user-defined attributes associated 
with it (these are listed as "generic attributes" in the attribute window). User-defined 
attributes can be included during import or applied afterwards if one would like to add an 
attribute that has not been predefined in the object. 
  
Other attributes found on an object will vary depending on what is defined for the object type 
in the object directory. 
 
Geometry 
As previously mentioned objects can exist without geometry. 
The objects handle geometry like any other attribute and can therefore have 0 to several 
geometries. 
  
Each geometry, with the exception of surfaces, have a set of attributes that provides 
information about: 
 

- The quality and accuracy of the geometry. 
- Where it is located, the height reference, where on the object the geometry is located 

and where in the ‘space’ the geometry is located (medium). 
- Properties such as field numerical code (feature code) and field code (alphanumeric). 
- A set of dates: first digitalisation date, verification date and any update dates for the 

geometry. 
- The process history of geometry. 

  
If you cannot find an object type that fits the desired object you want to create in the model, 
then the object directory has a type designated as ‘unclassified object type’. 
This makes it possible to import all types of objects even though one may not find a matching 
object type in relation to data being inputted.  
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Properties/Attributes 
 
This window shows the properties of the selected item. The following items are available: 

 The Quadri model 
 Tasks 
 Objects 

 
If you select multiple items the properties will be summarized in the properties window. 
 
Picture below shows an example of EdgeOfFootway object seen in the Properties window. 
 

 
 
 
Process Info 
 
Process info displays system messages when tasks are performed. This may be error messages, 
but also information about what is being done, for example how many objects were imported. 
 

  



 

Novapoint 21 Base course                July 2018 10 

Exercise 1 - Starting a new project 
 
 
1. Double-click the Novapoint Base icon on your desktop to start the program. 
 

 
 
 

2. This dialog appears: 
 

 
 

Select the New button: 
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This dialog appears:  
 

 
 
 

3. Enter a model name – NovapointCourse 
Browse to a location for the project C:\Novapoint Base_Beginners course 
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Note that the name of the binder is set to the same name as the Quadri model. The 
binder name refers to the “binder” where the Quadri model is stored locally. Several 
Quadri models or subprojects may be linked to the same binder. 

   
  Click OK. 
 
 
4. You can now select a CRS (Coordinate Reference System) for you model. For the 

training course we select the values shown below that is in accordance with our input 
data: 

 

 
 
Select Finish. 
You have now set up a new Quadri model and Binder. 

 
The Quadri model is stored in the file structure below. Each time you save the project 
you get the option to save the Binder you have created. In addition, folders with road 
model files, water and sewerage files etc. will be created. A folder is created for each 
task that requires a file attachment. The folder receives a name corresponding to the 
task GUID (Globally Unique ID). 
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TIP: 
 
Under Program files and Novapoint 21 there are three commonly used functions: 
 

 
 
Check for updates – used to see if your version is the latest version and will install the latest 
update. 
 
Configuration – used to change the Novapoint language version and to select which 
AutoCAD you wish to use. The most stable is pure AutoCAD but Novapoint will work with 
AutoCAD Map 3D and AutoCAD Civil 3D. Can also be used to set which licence system you 
are using – FLEXlm or Vianova ID: 
 

 
 
Reset user settings – can resolve some issues if Novapoint is not responding normally.  
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Exercise 2 - Creating a summary template 
 
In this exercise, you will create a summary template. 
 
1. Click on Process in the explorer, then right-click on the mouse and select Insert 

Structure…  
 

   
 

 
2. Insert the structure as shown below: 
 

 
 
 
3. The Explorer tree is as shown below: 
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You can rename or delete any summary taks by selecting and right mouse click: 
 

 
 

 
4. Save your project by clicking the save button:  
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TIP:  
You can add your own Summary tasks either by:  
 

 Right click anywhere in the tree and select Summary Task: 
 

 
 

…and add a new Summary Task. 
 

 By marking a Summary Task anywhere in the explorer tree and by selecting 
from the menu: 

 

 
 
 

You can also create your own Process Template and use it in other projects: 
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Part 2: Import Basemap and modeling ground surface 
 
In part 2 you will import a text file with 3D mapping information, inspect the imported data in 
plan- and 3D view, and generate a terrain surface and edit it. 
 

Exercise 3 - Importing a Norwegian Mapping file (SOSI) 
 

1. Click the Summary Task 101 FROM SOSI in the Explorer tree: 
 

 
 
 

2. Select the Insert menu in the top menu ribbon. The Insert tool palette is displayed, 
giving options to import data of various formats. Click on Import Files. 
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3. Give the task the name Basemap SOSI. Then click Select Files (0): 
 

 
 

 
4. Browse to folder C:\Novapoint Base_Beginners course\MainData. Set the file type to 

SOSI. Select all SOSI files, except _Voyen_WS Network_UTM32-NN2000.sos, and 
select Open.  

 

 
 

 
5. This dialog box appears: 

 

  
 

Click CRS is correct - continue to proceed. 
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6. This dialog appears: 
  

 
 
Tick the Preview after Reading Files(s).  
 
We will not use any of the other options in this window now, so click OK to start 
importing the file. A small window with a progress bar is display whilst the file is being 
read.  

 
 

7. Back to the import ribbon, click Select Rules: 
  

 
 
 

8. In the Convertion Rule dialog, click on Standard (SOSI 4.0) and then click Select > > :  
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Note: Conversion rules are a set of rules that determine how the information in the file, in 

this case a SOSI file, should be converted into objects in the model. 
 

 
 
Click OK and you will return to the main window. 
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9. Click   and the conversion starts. After the file has been converted, the result 
will be displayed. 

 
 
Note:  In Novapoint, data that is not included in the conversion, will be displayed in a 

separate explorer tree and can be viewed. If this should be included, the conversion 
rule must be updated to include these elements. 
In the process window any errors in the import or with the imported data will be 
displayed.  

 
 

10. Click  to finish the import. 
 

 
11. The Explorer will now look like this, and include all the imported mapping files: 

 

 
 
 

12. Right-click Basemap SOSI in the explorer, and click on View in Plan. 
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You will now see the import in the vindow, and your screen will look like this. 

 

 
 
 

13. Save your project by clicking the save button:  
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Exercise 4 - Generating a terrain surface  
 
In this exercise, you will generate a terrain surface based on the terrain objects in the mapping 
file.  
 

1. Click on 201 GROUND SURFACE in the Explorer:  
 

 
 

Tip:  Click to highlight the relevant process (summary task) you want to import data for, 
before selecting the modelling task. The process name is then added to the summary 
task name. If you make a mistake, you can drag and drop a task to the correct location 
afterwards. 
 

 
2. Click on Modelling and then the  Ground Surface task:  

 

  
 
 

3. Type in a name for the terrain surface task, Existing G. Surface SOSI, and check that 
you have selected the correct sub-task. If you have highlighted a sub-task before 
starting the task then it will be selected automatically. 
 

 



 

Novapoint 21 Base course                July 2018 24 

4. Click on . This dialog comes up: 
 

  
 
Click the Tasks tab, and select first the import tasks that has elevation information for 
terrain as shown. 
 

  
 

Note: All features selected here will be highlighted in red in the plan- and 3D-view window in 
the background.  

TIP: use the view setup to 
group by type. 
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5. Click the Features tab, and select the feature types that will form the terrain surface. 
Select LandUseBoudary, ContourLine, and all features with “edge”, “delimitation” and 
“verge” in the name, as these are line geometry: 
 

 
 

 
 

 
   
  

TIP: use the view setup to 
group by feature type group. 
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Then finished with your selection, click the Close button.  
 
 

6. Click    to start the calculation.  
 

Note: You can control the calculation by selecting    
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7. Right-click Existing G. Surface in the explorer, and click on View in 3D. 
 

  
 
 

 
 
 

8. Save your project by clicking the save button:  
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Exercise 5 - Viewing the data in 3D  
 
You can now view the whole model in 3D. 
 

1. Select the whole model at the top of the process tree and right mouse click and select 
View in 3D:  

 

 
 
 

 
 

 
The buttons on the right side are used to navigate the view:  
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Navigation Features  
 
These Navigation features are available from the Home tab, the View tab and on the 3D view 
navigation pane. 
 

 Navigation feature Description 

 

Zoom Extend Press to zoom out to view the whole model 

  

Zoom In Press + to zoom in 
 

 

Zoom Out Press + to zoom out 
 

 
Zoom Selection Select object and press Zoom Selection to zoom in or out 

of the selected objects.  

 

 Double-click Double-clicking a selected objects does the same as Zoom 
Selection (short cut command "G") 

 
Select It is still possible to navigate even if you are in Select 

mode. You can scroll the mouse wheel to zoom in and out. 
Hold down the mouse wheel to pan and use the right 
mouse button to rotate the camera angle. Left mouse 
button is for selecting objects. 

 

Pan Use the left mouse button to pan. Hold down the mouse 
wheel to move the model. Use the right mouse button to 
rotate the camera angle.  
 

 
Orbit The left mouse button controls Orbit, drag the wheel 

around to control. Zoom in and out with the mouse wheel.  
 

 Orbit+zoom Combine Orbit and Zoom in/out by holding down the right 
mouse button and dragging the mouse forward and 
backward.  
 

 

Fly Fly in and out by holding down the left mouse button and 
dragging the mouse. The greater the distance from the 
centre of the window, the greater the navigation speed. Fly 
up and down by holding the mouse wheel down. Zoom in 
and out by scrolling the mouse wheel. Rotate the camera 
angle by holding down the right mouse button and 
dragging the mouse.  
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You can temporarily switch to other navigation options:   
 

Change 
navigation mode 

Description 

Alt Hold ALT key to temporarily switch to Orbit. Can be used in PAN or 
SELECT mode. Release the ALT key to return to the original navigation 
mode.  

Ctrl Hold CTRL key to temporarily switch to select the mode. Can be used in 
PAN or ORBIT mode. Release the key to return to the original 
navigation mode. 

 
 
Keyboard Navigation (WASD): 
The 3D view window also supports keyboard navigation. Navigation starts when you press a 
key. 
 
To end keyboard navigation press the Esc key. 
 

Key Description 
U Make a U-turn and turn direction angle 180 degrees. 
G Go to a highlighted object, or to a position defined by the crosshairs if 

highlighting is not enabled, for example in PAN mode. 
W Move forward 
S Move backward 
A Move to the left 
D Move to the right 
Q Move down 
E Move up 
Caps Lock When CAPS LOCK is turned off the navigation speed is constant 

(recommended). When CAPS LOCK is on, the navigation speed is 
dynamic and is based on the distance from the view point position to 
the model.  

Shift Hold down the SHIFT key to reduce the navigation speed. This must be 
combined with one of the direction keys, for example. W. When the 
SHIFT key is released, the navigation speed returns to normal.  

CTRL Hold down the CTRL key to increase navigation speed. This must be 
combined with one of the direction keys, for example. W. When the 
CTRL key is released, the navigation speed returns to normal.  

 
 
 

 

Fly along a line Select the base line you would like to fly along.  

 
Previous Zoom Previous to view the previous section 

Next Next Zoom to view the next section  
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2. At the bottom of the program you have options to select the drawing rules for the 
window. Click to display a list of available rules.  

 

 
 

 
3. You can select from a wide range of Drawing rules. Below the Draw all drawing rule 

has been selected: 
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TIP:  You can select a number of tasks to be displayed in 3D by holding the Ctrl-key down 

and selecting the tasks you want displayed together.  Select, right mouse click and 
View in 3D. 

 

  
 

You can also “Drag and drop”. You can e.g. have the task Existing G. Surface SOSI 
active in the view. Now drag and drop the task Basemap SOSI right in the window to 
see them together in the view. 
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Exercise 6 - Editing the terrain surface 
In this exercise you will learn different methods to edit the groud surface.  
 

1. After navigating around the model we can find areas where the mapping data is 
incorrect, e.g. as shown below: 

 

 
 

 
 

Some of the objects that have been used as the basis for the Ground Surface 
calculation have either incorrect elevations or they should not have been included in 
the Elevation input. 
 

 
 
 
 



 

Novapoint 21 Base course                July 2018 34 

2. Zoom in on the area shown below. This is at the bottom left of the model. 
 

 
 

 
3. You can now check the point information for lines that have been used as Elevation 

Input.  
 

4. Click . Select a line with incorrect elevation. If there are multiple objects in the 
same area they will be displayed as shown and you can select the required object:  

 
 

 
 
 Click on Arealbrukgrense (=LandUseBoundary) and the selected element is highlighted 

in red: 
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Object information is shown in the Properties window:  
 

 
 
It is clear that this object type should not be part of the Ground Surface calculation. 
This object should be removed from the Elevation Input to the Ground Surface task. 

 
 

5. Select the Ground surface task Existing G. Surface SOSI. Right mouse click and select 
Edit task as shown:  

 
 
 

6. Select Elevation input as shown: 
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7. Click on Features. Use the filer to find the required object by writing landuse.  
 

 
 
Deselect LandUseBoundary as input, and click Close. 
 

 

8. Click  to calculate and see the result of the change.  
 

 
 

9. Click . 
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TIP:  You can also deselect tasks in the Elevtaion Input. 
E.g. you could deselect the file Import_LandUseboundary_u.sos.  

  

 
 
  

10. Zoom in to another area we can edit: 
 

  
 

Click one of the lines with an “incorrect” elevation.  
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In the properties window, click on Details and examine the point details.  

 

  
 
 This point is clearly incorrect, as it is 15 m over the other points. Select in the cell, right 

mouse click and select Set undefined height.  
 

  
 
 You could also set all the points as undefined by selecting the coloumn. Then they will 

no longer be included in the Ground Surface calculation. 
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11. Recalculate the Existing G. Surface SOSI by right clicking the task in the explorer, select 

edit task and   button. See that the changes are updated.  
 

TIP:  You can also use the Interpolate z-values function if you want to interpolate between a 
start and end value.   
 

  
 

12. Continue to edit until you have a Ground Surface without errors. 
 

   
 

13. In some areas, e.g. bridges, the triangulation has included bridge edge lines in the 
Ground Surface calculation as shown in the example below. These can easily be 
removed.  
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Often it is usefull to exclude surface objects in the 3D view so it is easier to 
add/subtract single objects.  
 
View when the surface objects are included: 
 

 
 
The same view when Bridge decks and road surfaces are turned off:  
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A method to remove single objects from the Elevation Input is with the 3D view open, 
then right click Existing G. Surface SOSI in the explorer and Edit task. Then click the 
small arrow to the right of the Elevation Input > Features (xxxx).  
 

 
 
Click Select Objects: 

 
In the select mode hold in the Ctrl and select the object you want to remove from the 
calculation. You will see a minus sign when selecting objects included in the calculation 
and a + sign when over objects that can be selected. Selct the required object from the 
list. 
 

 
 
The line will now be deselected. 
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OBS! Keep an eye on the number of objects selected in the Ground surface task so you 
don’t end up with just 1 object. 

 

 
 
TIP:  If you lose control over the number of features (select without holding the CTRL key 

down), then end the task by clicking Cancel, and the task will roll back to where you 
started.  
 
 

14. After deselecting the lines, click  to calculate the ground surface with the new 
information. 

 
 

15. Save your project by clicking the save button:  
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Exercise 7 - Importing other file types - KOF and LandXML 
 
In this exercise you are going to import two other common file formats, KOF and LandXML.  
 

1. Create a new Summary Task - 103 FROM KOF, by selecting 10 IMPORT, right clicking, 
and click Summary Task. 

 

 
 
 

2. A KOF file is imported in the same way as a SOSI file by selecting the Insert tab and 
clicking the Import button. 

  

 
 
  Click Select Files, and select Cable.KOF file from folder \Main Data: 
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3. This dialog appears:  
 

 
 

A KOF file contains no reference to the coordinate system. You must know which 
 coordinate system the KOF file is in, and decide whether the coordinate reference 
system of the file is the same as the Quadri model. In this case select 
File CRS is the same as active Quadri model as shown above. 

 
  This dialog appears: 
 

 
 

  Tick the Preview checkbox as shown and press OK.  
 
 

4. Click on Select Rules. 
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Select KOF to Proxy Objects and press the Select>> button. Then press the OK button.  
 
 

5.  Click Preview :  
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6. Finish by clicking . 
 
 

7. Now we will import an LandXML file. 
Create a new Summary Task - 104 FROM LANDXML, by selecting 10 IMPORT, right 
clicking, and click Summary Task. 

 

 
 

 
 

 
 

8. A LandXML file is imported in the same manner as SOSI, KOF or other file types. 
 

Click 104 FROM LANDXML in the explorer. Select the Insert tab and click the Import 
button. 

 

 
 
 

9. Click Select Files. Select LandXML as the file format, click the file 
1830_Formation Plan.XML and click the Open button. 
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This dialog appears: 

 

 
 

A LandXML file contains no reference to the coordinate system. You must know which 
 coordinate system the KOF file is in, and decide whether the coordinate reference 
system of the file is the same as the Quadri model. In this case select 
File CRS is the same as active Quadri model as shown above. 

 
  This dialog appears: 
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  Tick the Preview checkbox as shown and press OK.  
 
 

10. Click on Select Rules. 
 

  
 

 
 

Select Conversion byLandXMLObjectType, click Select>>, then the OK button.  
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11. Click , then . 
 

 
 
 

12. Save your project by clicking the save button:  
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Exercise 8 - Import of surveying field data 
 
In this exercise, you will see how we can import survey data for an existing road and combine it 
with the mapping data we imported earlier.  
 

1. First, import the survey data from a DWG.  
 

Click the Summary task 102 FROM DWG:  
 

 
 
 

2. Click Insert and Import files. 
 

 
 

 
3. Click Select Files.  

 

 
 

Select DWG as the file format, click the file SurveyData.dwg and click the Open button. 
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4. This dialog appears: 
 

 
 

A DWG file contains no reference to the coordinate system. You must know which 
 coordinate system the DWG file is in, and decide whether the coordinate reference 
system of the file is the same as the Quadri model. In this case select 
File CRS is the same as active Quadri model as shown above. 

 
 

5. This dialog appears: 
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  Tick the Preview checkbox as shown and click OK.  
 

 
 
 

6. Click on Select Rules. 
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7. This dialog appears: 
 

 
 
In a Quadri model the feature types play a key part in the information model. In order 
to convert the elements from the DWG we are importing, we need to make a 
convertion rule. We have here a DWG which consist of different CAD layers, that we 
want to assign to different feature types. 
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8. Click on the  button in the dialog. 
 

 
 
Give the convertion rule a name, e.g like the picture shows. Then click Save, and this 
dialog appears: 
 

 
 
Click on Create Rules from Preview model. 
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9. This dialog appears: 
 

 
 
The dialog shows us that the Source Feature here is CadCurves (= line geometry). 
Tick for CadCurves, and then click Next. 
 
 

10. Tick for layer. By doing that we will list up the information in the file by the CAD layer. 
 

 
 
Click Next. 
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11. Click Finish. 

 

 
 
 

12. Now, the CAD layers from the file we are importing will be converted to objects. 
Click the field in the Destination Feature column. You will now get a list of all the 
features that you can select the Feature Catalogue in Novapoint (for the specified 
geometry type, in this case lines/curves). 
 

 
 
Fill in as shown below, or select features from the list that you think fit best. 
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When finished, click OK. 
 
 

13. You are now back in the Convertion Rule dialog. 
 

 
 
Select the convertion rule you just made. It will be located under Custom convertion 
rules. Click Select>>, and finish by clicking OK. 
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14. Finish the import by clicking the  button. 
 

 
15. Click on the import Import SurveyData.dwg from the Expolrer, right click, and 

View in 3D. 
 

 
 
 
16. Save your project by clicking the save button: 
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Exercise 9 - Ground surface of the surveying data 
 

1. Now we will create a surface from the imported survey data. 
 
 Click on 201 GROUND SURFACE in the Explorer.  
 

 
 
 

2. Click on Modelling and then the Ground Surface task:  
 

  
 
 

3. Type in a name for the terrain surface task, TIN SurveyData. 
 

 
 
 

4. Click on . This dialog comes up: 
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Click the Tasks tab, and select Import SurveyData.dwg. 
 

 
 
Click Close. 
 

5. Finish the task by clicking , and the ground surface task is created. 
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6. We can now view the import Import Survey.dwg together with TIN SurveyData. Select 

both in the explorer, right mouse click and View in 3D. 
 

 
 
 

 
 
We can see that it is neccecary to limit the long triangles. We can do that by removing 
long-edge triangles at the edge of the triangulation. 

 
 

7. Select TIN SurveyData in the Explorer and Edit Task: 
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 Click Settings . 
 

 
   Click on TIN, and try first the max length of the edge at 50 m. 

 

 
 
Click Save to Task. 
 

Click  to build the TIN model. 
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It looks better, but is still not perfect. Gå back to Settings and try different values to 
optimize the TIN surface. Click on Preview to view the result. In the picture below we 
have set the value to 13 m, and it looks like a good value. 
 

 
 
 

8. Click . 
 
 

9. We will now clip a hole in the original Existing G. Surface SOSI, using TIN SurveyData 
as the hole. 

 
Select Existing G. Surface SOSI in the Explorer and Edit Task. 
 

 
 

  Click Holes and select TIN SurveyData under tasks:  
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Click Close.  
 
 

10. Click  .  
 
The original ground Surface now looks like this: 
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We can now use these two Ground surface tasks as a calculation basis for our 
road/rail/WS tasks. 
 
Note under Settings in the Existing G. Surface SOSI task, we can set the hole to be 
destructive and then the triangulation will use the boundary from TIN SurveyData as 
part of the triangulation: 
 

 
 
 

11. Save your project by clicking the save button: 
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Exercise 10 - Collection  
 
When working with a project it is very useful to create a collection task that holds tasks and 
features for existing situation as a calculation base. Collection tasks can also be used for 
illustrations objects. In this exercise, you will create a collection task that will be used for a 
alignment, road, rail, WS calculation. 
 

1. Click the Summary task 20 TERRAIN:  
 

 
 
  

2. Click on the Insert tab and click on Collection. 
 

 
 
 

3. Type in the name Calculation basis. 
 

 
 
 

4. Click on Select Features. Under Tasks select the two Ground surface tasks. 
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  Click Close. 
 
    

5. Click  .  
 
 

6. Save your project by clicking the save button: 
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Part 3: Modeling existing situation 
 
In this part of the course, we will look at how we can transform selected objects in the 
mapping data into 3D objects. This includes buildings, bridges, hedges and utility poles. 
 

Exercise 11 - Buildings 
The modeling of buildings we do in the same function by generating roof surfaces, and 
vertically extrude them to the ground surface.  
  

1. Before you start the function it is a good idea to inspect the map data in 3D, this will 
make it easier to see all the objects you select. 
 
Select NovapointCourse at the top of the tree in explorer, right click and select 
View in 3D. 

  
Use the navigation features to zoom in and twist the map data in 3D so you can clearly 
see some of the buildings as shown below: 

 

   
 
 

2. Click the Summary task 30 EXISTING SITUATION:  
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3. Click on Modelling and Building as shown below: 
 

 
  
 

4. Input a suitable name - Buildings:  
 

 
 
 

5. Click Select Building Info. In the Dynamic Query dialog that appears, click Tasks and 
select Import Building_u.sos. 
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Click Features:  
 

 
 

Browse for features FootprintRoof in the search field. Note that the features you have 
selected will be is highlighted in the 3D model in red.  
Click the Close button. 
 
 

6. Click Features to follow. 
 

   
 
Select Existing G. Surface SOSI and then Close.  
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7. In the field Extrude vertical enter -2: 
 

 
 
All the buildings will now be extruded from the roof heights, and 2 m under the ground 
surface, to simulate a celler.  

 
 

8. Click    . 
 
 

9. In the Explorer, select the Buildings task, right mouse click and View in 3D: 
 



 

Novapoint 21 Base course                July 2018 72 

 
 

 
10. Save your project by clicking the save button: 
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Exercise 12 - Modeling other 3D objects 
 
In this exercise, we will model more existing features as 3D objects. The examples will include 
bridges, hedges and utility poles. It is possible to create 3D objects in this way using points, 
lines, polygons and surfaces.  
 
Bridges 
 

1. In the explorer, scroll down to the bottom. Click the +mark in front of Features. 
 

 
 
You will now get a list of all features that are in your model. Scroll down and find 
BridgeFootprint. Click the + in front of BridgeFootprint to list all BridgeFootprint 
surfaces found in your model. All features have a unique identification. 
 
Click BridgeFootprint, right mouse click and select View in 3D.  Zoom in on some of 
them: 
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2. Now scroll up in the explorer, and click the summary task 30 EXISTING SITUATION.  
 

 
 

 
3. Click Modelling and Extrude:  

 

 
 
 

4. Input the name 3D Bridge:  
 

  
  
 

5. Click Select Feature(s). Under Tasks, select Basemap SOSI. 
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As the bridges are surface geometry, we select Surface spatial input. 
 

 
 
Under Features select BridgeFootprint.  
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6. In this case we want to create a volum from a bridge surface, and give it a Vertical 
Offset(m) of -2 (thickness 2m).  

 

  
 
 

7. As Output Feature, first un-tick Modify Input Features, and select BridgeSurface: 
 

 
 

 

8. Click  .  
 
 

9. Click the 3DBridge task in the explorer, right mouse click and View in 3D. 
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TIP:  The 3D volume objects can be used as Illustration objects in Alignment Design and in 
the Road/Rail model. They will appear in the vertical alignment design window and in 
the road/rail Cross section viewer. 
 
 

10. Save your project by clicking the save button: 
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Hedges 
 

1. Again, scroll down in the explorer under Features. Now find the feature type Hedge, 
right click and View in 3D.  

 

 
 
We see all the Hedges in 3D as single line objects, and we will add volume geometry to 
them 

  
 

2. Now scroll up in the explorer, and click the summary task 30 EXISTING SITUATION.  
 

 
 

 
3. Click Modelling and Extrude:  
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4. Input the name 3D Hedges:  
 

  
  

Now, instead of selecting all the hedges from the list, we wil first select one or two 
straight from the view window. This is a good method to use when there are many 
instances of a feature type. 

 
 

5. Click the down arrow next to Select Feature(s), and click on Select objects. 
 

 
  
 Select one or two hedge lines in the window. 
 

   
 

6. Under Normal Profile, fill in these values: 
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7. Click Feature to Follow. 
 

 
 
  Select Existing G. Surface SOSI under tasks. 
 

 
  
Click Close.  
 
 

8. In Vertical Offset enter a value of -0.5 m under the ground surface, to represenet the 
volume of roots under the hedges. 
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9. As Output Feature, select Modify Input Feature. Then, the volume geometry is saved 
as additional property to the imported hedges, instead of duplicating the number of 
this object type. 
 

 
 
 

10. Click , and the two hedges are modelled as a 3D hedge. 
 

 
 
 

11. You can now extend the task to include all hedges. Click Select Features(s) and select 
all Hedges. 
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12. Click Close, then  . 
 
 

13. Check all your hedges against the ground Surface, by selecting the two tasks, right 
mouse click and View in 3D. 
 

 
    
 
  Optionally, select another drawing rule, to view this with textures. 
 
  



 

Novapoint 21 Base course                July 2018 83 

Utility poles 
 

1. From Features at the bottom of the Explorer, select UtilityPole and View in 3D. 
 

    
 
 

2. Now scroll up in the explorer, and click the summary task 30 EXISTING SITUATION.  
 

 
 

 
3. Click Modelling and Extrude:  
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4. Input the name 3D Utility poles:  
 

  
  
  

5. Click Select Feature(s). Under Tasks, select Basemap SOSI. 
 

 
 

As the Utility poles are point geometry, we select Point spatial input. 
 

 



 

Novapoint 21 Base course                July 2018 85 

 
Under Features select UtilityPole.  
 

 
 
 

6. Under Normal profile, fill in the values as shown:  
 

 
 
 

7. In this case we have a z value for each pole that we assume is the top of each pole and 
we want the pole volume to extrude to the Ground surface.  

 Click Feature to Follow: 
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Select Existing G. Surface, and then click Close. 

 
 

8. As Output Feature select Modify Input Features.  
 

 
 
 

9. Click  and each pole is modelled.  
 
 

10. Now, it looks like nothing did happened, but if we zoom in a lot on one of the poles, 
we accually can see the result. 
 

 
 
 

 
 



 

Novapoint 21 Base course                July 2018 87 

11. Select one of the Utility poles and look at its properties, it now has a volume geometry.  
 

 
 
In this case it looks like the z value for each pole was the Ground Surface height. We 
can now change the geometry and give each pole a height of for example 8 m. 
 
 

12. Clear the Feature to Follow: 
 

 
 

  Instead, enter a value of 8 m for the Vertical Offset: 
 



 

Novapoint 21 Base course                July 2018 88 

 
  
  

13. Click   . 
 

 
 
 

14. Save your project by clicking the save button: 
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Exercise 13 - Modelling of existing cables 
 
In this exercise, we will model the cables we imported from the KOF format earlier. They are 
currently in 2D with elevation 0, so we will first place them 0.8 m below the ground surface. 

 
1. Click the summary task 30 EXISTING SITUATION.  

 

 
 

 
2. Click Modelling and Move Vertically:  

 

 
 
 

3. Input the name Move vertically Cables from KOF:  
 

  
  
  

4. Click Select Feature(s). Under Tasks, select Import Cable.KOF. 
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Click Close. 
 
 

5. Select Surface, select the Existing G. Surface SOSI and Close. 
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6. Enter an offset value -0.8 m and tick Add points to follow the surface better. 
 

 
 
 

7. Click . 
 

Right click Import Cable.KOF from the explorer, and View in 3D. The imported cables 
now have a z values: 

 

 
 
 

8. Click the summary task 30 EXISTING SITUATION.  
 

 
 

 



 

Novapoint 21 Base course                July 2018 92 

9. Click Modelling and Sweep:  
 

 
 
 

10. Input the name Sweep cables:  
 

  
  
  

11. Click Select Feature(s). Under Tasks, select Import Cable.KOF. 
 

 
 
Click Close. 
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12. Fill out the Normal Profile like this: 
 

 
 
 

13. As Output Feature select Modify Input Features.  
 

 
 

 

14. Click   . 
 
 

15. The result when viewed in 3D: 
 

 
 

 
16. Save your project by clicking the save button: 
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Part 4: Presentations, orthophotos, map delineating and 
sections 
 
The views of the model you have used so far in this course have been temporary. We can 
select multiple tasks or objects to display at the same time, though we quickly get many 
window tabs open (as shown below). 
 

 
 
To close the windows, click X on the tab to close it, or press right mouse button over a tab and 
click Close All Other Windows, or Close All Windows. 
 
If you want to save specific views or presentations, you will create a permanent plan or 3D 
presentation. These can also be linked to ortofoto or WMS. The plan presentation is also used 
to draw to AutoCAD. 
 

Exercise 14 - Presentation task of map data in plan 
 
To export the map data to AutoCAD we can create a presentation task of type Plan, which can 
then be exported to DWG.  
 

1. Click the summary task 90 PRESENTATIONS.  
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2. Click View and Plan Presentation. 
 

 
 
 

3. Enter the name MapDrawing SOSI. 
 

 
 
 

4. Click Source Features(s) and open the Tasks tab. 
  

 
 
Select Basemap SOSI and Close. 
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5. As Presentation Rule, select Base Map. 
 

 
 
 

6. Click  and this Presentation view is now stored in the explorer in Novapoint, and 
can also be selected from AutoCAD.   
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Exercise 15 - 3D presentation of all objects with orthophotos 
 
We can also make a permanent presentation of the 3D window, showing objects in our model 
draped with orthophotos of the terrain. We will first import the ortophoto. 
 

1. Click the summary task 90 PRESENTATIONS.  
 

   
 

2. Click Insert and Ortophoto. 
 

  
 
 

3. Enter the name Ortophoto. 
 

   
 
 

4. Click , and browse to the folder 
C:\Novapoint Base_Beginners course\Aerial photo 
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Click OK. 
 
 

5. Under Draping, Select features and select both Existing G. Surface SOSI and 
TIN SurveyData. 
 

 
 

 
 
Click Close. 
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6. Click Preview 3D. 

 

 
 
 
A 3D window with the complete model and the selected ortophoto is displayed: 

 
 

 
 
 

Click   . 
 
 

7. Now we will make the 3D presentation. 
 
Click the summary task 90 PRESENTATIONS in the explorer. 
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8. Click View and 3D Presentation. 
 

 
 

 
9. Enter name 3D of whole model. 

 

 
 
 

10. Click Source Features and Select All:  
 

 
 

Click Close.  
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11. Under Presentation Rule select Default. 
Under EDS select Ortophoto:. 
Also set Sky and Horizon on. 
 

 
 
 

12. Click    . The 3D-presentation is opened in a new window:  
 

 
 
 

17. Save your project by clicking the save button: 
 

 
 
 

Tip: You can also drape the ortophono on e.g. bridges or buildings, in adition to the ground 
surface. To do so, set the Ortophoto-task’s draping on these tasks as well. 
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Exercise 16 - Connect to WMS 
 
To connect to a WMS (Web Map Service) is a quick and easy way to add an information layer 
to your project.  
 

1. Click the summary task 90 PRESENTATIONS.  
 

   
 
 

2. Click Insert and WMS. 
 

  
   
 

3. Enter name WMS - Geonorge. 
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4. If you run Novapoint with Norwegian configuration, you can click Templates at the left 
of the ribbons dialog, and use any of the stored templates. These are for nmorwegian 
coordinate systems. In international configuration, you can type in the URL yourself: 
 

https://openwms.statkart.no/skwms1/wms.fkb4?request=GetCapabilities&service=WMS 
 

 
 
 

5. Click Select layers, and this dialog comes up. Select any layers you want. Here we 
select all by ticking in front of FKB4 WMS. 
 

 
 
 

6. You need to select the correct CRS for the WMS. 
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7. Under Draping select which objects the WMS should be draped on, Normally the 
Ground Surfaces. 
 

 
 

 
 
 

8. Click Preview 3D. 
 

 
 
A 3D window with the complete model and the WMS is displayed: 
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9. Click   . 
 
In order to view the WMS task from the explorer, you must select both the WMS task, 
and also the terrain surface tasks, and view them together in 3D. You can’t only show 
the WMS task by itself. The view you get depends on which layers you have chosen. 
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Exercise 17 - Generating longitudinal section through the model 
 
In this exercise, we will generate a longitudinal section. 
 

1. Sections can only be generated through a plan window. 
  

Close all view tabs by right mouse click on a tab and click Close All Windows. 
Open a plan window for the whole model by right mouse clicking the whole model in 
the explorer, and View in Plan: 
 

 
 

Zoom in to an area as shown: 
 

 
 
 

2. Click the summary task 90 PRESENTATIONS.  
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3. Click View and Long Section. 
 

 
 
 

4. Under Baseline, click Draw. 
 

 
 
Using your left mouse button click on the two points along which you want to make 
the long section. The points are highlighted in the window and a corridor is created on 
the right and left sides.  
 
Point objects located within the corridor will be part of the section, whilst sections 
through e.g a ground surface will be formed exactly along the line. You can adjust the 
Length of the section and the Section Depth.   
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5. The next step is to select what objects should be included in the section calculation.  
 
Click Source Features and Select All. 
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6. Under Presentation Rule select Default. 

 

 
 

7. Click   and the long section is shown.  
 

 
 

 
8. Save your project by clicking the save button: 
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Exercise 18 - Generating cross sections through the model   
 
In this exercise, we will generate a cross sections through a plan window. 
 

1. Sections can only be generated through a plan window. Open the plan window of the 
whole model from the previous exercise. 
 
Zoom in to an area as shown: 
 

 
 
 

2. Click the summary task 90 PRESENTATIONS in the explorer. 
 

   
 
 

3. Click View and Cross Section. 
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Using your left mouse button click on the two points along which you want to make 
the cross section. The points are highlighted in the window and a corridor is created on 
the right and left sides.  
 
Point objects located within the corridor will be part of the section, whilst sections 
through, for example, a terrain surface will be formed exactly along the line. You can 
adjust the Length of the section, the Section Depth and the Section Interval.   
 
Fill inn with these values:  
 

 
 
 

 
 

4. The next step is to select what objects should be included in the section calculation.  
 
Click Source Features and Select All. 
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5. Under Presentation Rule select Default. 
 

 
 
 

6. Click   and the long section is shown.  
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Select other cross section along the section bar, either with the arrows or by draging 
the blue triangle back and forth. Double-click on a profile to go directly to that. 
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TIP:  You can have a number of windows open and see the plan, 3D and cross section at the 
same time: 

 

 
 
 

7. Save your project by clicking the save button: 
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Exercise 19 - Start AutoCAD and draw the mapping data  
 
In this exercise we will start AutoCAD from Novapoint Base and draw out the basemap, which  
we can use for alignment design and drawing production.  
 
To start AutoCAD from Novapoint Base click the icon at the bottom right of the program, as 
shown below: 
  

 
 
By clicking the arrow on the right, you will open up an option menu, where you can choose to 
open AutoCAD on startup of Novapoint. 
 
AutoCAD must always be started from within Novapoint Base in order to establish contact with 
Novapoint. 
 
There are two ways to produce a drawing from Novapoint Base. 
 
 
Method 1: Create an Export task to DWG 
  
This is the fastest and recommended method. 

 
1. Start by making a new summary task. Right click at Process  at the top of the explorer 

to do so. Give the name X EXPORTS. 
 

 
 
 

2. Click Output and Export to DWG: 
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3. Enter the task name Export Basemap. 

 

 
 
 

4. Select the plan presentation you want to export. In our case, we only have the one 
made earlier, MapDrawing SOSI. Deselect to draw in 3D, as this is a 2D map. 
 

 
 

5. Click , and enter the file name and path: 
 

 



 

Novapoint 21 Base course                July 2018 117 

 
Method 2: Draw a plan presenetation directly to AutoCAD 

 
1. In AutoCAD, in the Novapoint ribbon, click Plan Presentation.  

 

 
 
 

Select the correct plan presentation: 
 

 
 
 

2. Click Draw. 
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3. Save the drawing as MapdrawingSOSI.dwg in folder 
C:\Novapoint Base_Beginners course\Drawings   
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Part 5: Sub-surface layers and existing WS 

Exercise 20 - Importing boreholes to rock 
 
In this exercise, we will import the surface layer data from an AutoCAD drawing that contains 
boreholes to rock.  
 

1. Click the Summary task 102 FROM DWG:  
 

 
 

 
2. Click Insert and Import files. 

 

 
 

 
3. Click Select Files.  

 

 
 
Select DWG as the file format, click the file RockBoreHole.dwg and 
click the Open button. 
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4. This dialog appears: 

 

 
 
Select File CRS is the same as active Quadri model as shown above. 

 
 

5. This dialog appears: 
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  Tick the Preview checkbox as shown and click OK.  
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6. Click on Select Rules. 
 

  
 
 
This dialog appears: 
 

 
 
  

7. Here we use _CAD-Geometry to Unclassified objects convertion rule, which will 
convert to the feature ProxyFeature. Click Select>>, then OK. 
(If you want, you can make you own convertion rule and convert to the feature 
GeotechDrilling). 
 

 

8. Click .  
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9. Save your project by clicking the save button: 
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Exercise 21 - Sub Surface layers 
 
In this exercise, we will generate sub-surface layers based on the borehole points we imported 
in the previous exercise.  
  

1. Select ImportRockBoreHole.dwg task in the explorer, right click and select View in 3D. 
These points will be the basis for the sub-surface layers.  

  
 

2. Click on 202 SUB SURFACE in the Explorer:  
 

 
 

 
3. Click on Modelling and then the Ground Surface task:  

 

  
 
 

4. Type in a name for the subsurface task, Subsurface Rock. 
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5. Click on Features (0). 
 

 
 
 

6. Click Tasks, and select ImportRockBoreHole.dwg. 
 

  
 
Click Close. 
 
 

7. Under layer Material select Soil (1).  
  

 
 

 
 
 
 
   

8. Click  . 
 

The layer material always defines the material over a layer. 
Under the lowest sub surface layer is always rock. 
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9. Select both Subsurface Rock and Import RockBoreHole.dwg from the explorer, and 

View in 3D:  
 

   
 

10. We see that there are long triangles that gives a wrong presentation of the rock layer. 
We wish to only have triangulations between the points. 

 
Edit the Subsurface Rock task by right clicking it, and Edit task:  
 

   
 
  Click Settings: 
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  This dialog opens:  
 

 
 

Under TIN select to Remove long-edge triangles at edge of model. 
Set the value to 50 m. Then click Save to Task  
 
 

11. Click  , and the sub surface task is updated:  
 

   
 
 Alternatly, adjust again and try with a different value. 
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12. When you are pleased with the result, click .  
 
 

13. Select Existing G. Surface SOSI, TIN SurveyData and Subsurface Rock in the Explorer, 
right click and select View in 3D:  

 

   
 
 
TIP:  It is also possible to use a 2D boundary line to limit a triangulation. 

1. Make a closed boundary line in AutoCAD, and import back to the model before 
they can be used. 

2. The boundary lines are drawn with the Draw Objects function in Novapoint 
Base. 

 
 

14. Save your project by clicking the save button: 
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Exercise 22 - Sub Surface layer (bottom layer)  
 
For Sub surface layers we have a number of impoprtant principles: 
 

1. The volume under the Ground Surface must be unambiguous and clearly defined so 
that all the calculation routines for road, rail, WS… know which material they go 
through. The material type for a sub surface layer always defines the material over 
that layer. 
 
 

2. If a model only has a ground surface and no sub surface layers defined, the model is 
assuming the volume under the surface is soil. The picture below shows this:  
 

 
 
 

3. Under the last sub surface layer, the model always assumes there is a rock layer. In the 
picture below a top soil layer is defined under the ground surface, thus under this 
layer, the sub surface is rock: 
 

 
 
 

4. If a sub surface layer cuts through the ground surface, the calculation routines will 
assume the ground surface is correct, and cuts the sub surface layer.  
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5. Sub surface layers should not cross each other. Use the triangulation routines to fix 
this if it occurs. Use priority/highest/lowest and create a new sub surface: 
 

 
 
 

6. Sub surface layers with the same material type should not overlap in plan. Use a 
different material type. There are 25 material types to select from. 
 
To ensure an unambiguous sub surface description, it is necessary to define a dummy 
layer that defines the top rock layer. Over this layer will be soil. In our case, we have 
defined an area that is top rock, and over this we have soil. Now we need to define 
what is outside of this area. 
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1. Click on 202 SUB SURFACE in the Explorer:  
 

 
 

 
2. Click on Modelling and then the Ground Surface task:  

 

  
 
 

3. Type in a name for the subsurface task, Bottom Surface. 
 

 
 
 

4. Click on Surface to Follow (0). 
 

 
 
 

5. Click Tasks, and select Existing G. Surface and TIN SurveyData. 
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Click Close. 
 
 

6. Set the Vertical Offset to minus 70 meters (-70).  
 

   
 

 
7. Now, we want to clip a hole where we have the rock surface we defined from earlier. 

 
Click Holes under Select Boundary.  
 

   
 
   

8. Select the task Subsurface Rock: 
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9. Under Material Type select Soil [1]. 
 

 
 
 

10. Click  . 
 
 

11. In the explorer, select the task Bottom Surface and View in 3D: 
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12. In the explorer, select the tasks Existing G. Surface SOSI, TIN SurveyData, Bottom 

Surface and Subsurface Rock, and View in 3D:  
 

   
13. Save your project by clicking the save button: 
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Exercise 23 - Updating the collection task 
 
Now that we have defined sub surface layers in the model, which we will also calculate against, 
we need to update the collection task to include these. 
 

1. Right click Calculation basis in the explorer, and click Edit task. 
 

  
 

 
2. Click Select Features. 

 

 
 
 

3. Include Bottom Surface and Subsurface Rock. 
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Click Close. 

 
 

4. Click . 
 
 

5. View Calculation basis in 3D: 
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Part 6: Supplementary data and miscellaneous 

Exercise 24 - Draw object 
 
In this exercise, you will use the function Draw Object to complement the model. In the 
example, we will draw a hedge. 
 

1. Open the plan presentation task MapDrawing SOSI. 
 

 
 

 
2. Zoom in on the area show in the picture: 

 

 
 
 

3. Click on 80 LANDSCAPE in the Explorer:  
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4. Click on Modelling and then the Draw Object task:  
 

  
 
 

5. Type in a name for the task, New hedge, and set the Result feature to Hedge. 
 

 
 
 

6. Click on Line. 
 

 
 
 

7. Draw a line for the hedge. 
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Use the assist panel in the top right corner as help. 
 
When you have drawn the hedge line, click Enter on the keyboard. Note that the line 
“disappears” from the view. This is because we have the plan view of the MapDrawing 
in the background, which is not set up to show the line just drawn. 
 
 

8. Click  . 
 
 

9. Drag & Drop the Draw Object task in to the view, to see the hedge. 
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10. Click on the hedge in the view. 
 

 
 
 

11. In the Properties view, click on Details. 
 

 
 

12. Set the first and last vertex point on the line to z = 32. 
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13. Select all the vertex points by holding Shift on the keyboard, right mouse click, and 

Interpolate z-values. 
 

 
 
They will all get the height z = 32 m. 
 

 
 
 

14. Lastly, we model the hedge. 
 
Click the summary task 80 LANDSCAPE, click on Modelling and Extrude. 
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15. Give the task name 3D new hedge. 
 

 
 
 

16. Select New hedge as the input, set Center and width 0.5 meter. 
 

 
 
 

17. Select Existing G. Surface as Feature to Follow, with an offset of –0.5 m. Also select to 
Modify Input Features. 
 

 
 
 

18. Click  . 
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19. View both Existing G. Surface SOSI and 3D new hedge in 3D. 
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Exercise 25 - Miscellaneous 
 

 Before we finish this section on Novapoint Base it is a good idea to check and possibly 
clean up the Explorer. That way, you get to organize the explorer in your project as you 
wish. 

 

 Novapoint saves the model automatically every time you click the  button in one of 
the functions. However, you must make sure to click save while using other functions 
that creates, cleans and clears in the Explorer.  

 
At AutoSave, the .GD* files are saved, and there are different content in relation to the 
backup file. If you close a Quadri model and answer No to saving, the database is 
overwritten with the contents of the backup file so that you return to how the 
situation was at the last user-defined save. 
 
When you open a model, the system runs a check if the content is the same in the 
model as in the backup file. If it is not, the user is informed that the model is restored 
after abnormal termination, and the model will be overwritten with the copy in the 
backup file. 

 

Every time you click Save All     the backupfile is updated. This 
backup file is a copy of the complete project.  

 
 

 You can always select a task and drag it to move it to another location in the 
explorer.In addition; you can right click a task,and in the menu that appears, you can, 
e.g., rename or delete a task: 
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 If you delete a task that has content, you will be prompted with this dialog: 
 

 
 

Ensure that you also tick the Also delete result features check box so that objects do 
not remain in the project model when the task is deleted. 

 
 

 It is not possible to delete tasks that are in use by other tasks. If you try, you will 
receive this warning: 

 

 
 

If you still want to delete this task, you need to first remove it from all other tasks.  
 
 

 To see which tasks relate to each other, you can right-click a task in the explorer and 
select Make Dependencies Graph: 
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 You can take screenshots of the window by clicking  which is under  
View > Presentations. By clicking the small drop-down arrow below the icon first, you 
can select settings. Here you can set up the image format, as well as how and where 
the image is saved. 

 
 

 End the course by saving your model. 
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Appendix 1: Server project - Quadri 
A Quadri project enables multiple users to work with the same Quadri model, hosted on a 
server with a unique IP and Port. 
 

 
 
Each Quadri server can contain of multiple Quadri models.  
 
Each Quadri model can contain a hierarchy of Quadri projects where each project has a unique 
ID which is used to connect to Novapoint Base. CRS is attached to a Quadri model, so all 
projects has the same CRS. 
 
It is recommended to create a new Quadri model for each project. 
 
 

 
 
A user is working towards a Quadri project by checking out a workset (local copy) of the 
model. The user works locally on his copy of the model, and can recieve / share from the 
project server. A user has the ability to extract multiple worksets from the same Quadri 
project. 
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Important  
 

• The project manager should establish a project structure that all participants are 
familiar with. This should be monitored daily. 

• All tasks and objects should be quality assured before they are saved to the server. 
Have one person who is responsible for basic data. 

• When sharing to the server, make shure you share everything (all tasks and objects) 
you've created in your local workset. 

• Remember to share regularly. You can still make changes after you have shared. 
• When receiving, you get everything back. 
• With Quadri Model Manager (QMM), you can disconnect a workset. This means that 

the workset can no longer be used to work towards a shared model. 
• There is a receive embedded in the reservation, because you must be sure that the 

changes are making changes in an updated version of the model. 
• You may reserve / release entire worksets by right-clicking in the project name in the 

explorer 
• You can reserve / release parts of the workset by selecting those particular tasks in the 

explorer 
• You can delete a model with QMM. Then all the projects, all tasks, all objects, all users 

and absolutely everything is deleted. 
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Create a project 
 Models are set up in the Admin program Quadri Model Manager (QMM). 
 It is recommended to have one model per project. 
 Each model has one or more administrators, and a number of possible users. These are 

set up in Quadri Model Manager. 
 Only the model administrator can set up a project. It is done in the Project Admin. 

 
 

1. Start Novapoint.  
 
 

2. Click the (N) and select Manage Projects. 
 

  
 
 

3. In the dialog that comes up, click . This dialog then comes up: 
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Fill inn with the information you have gotten from the project admin. 
 
 

4. For a course on the Novapoint server, fill in with URL (name or IP) and alias: 
 
URL: 195.254.218.218 
Alias: Course – 195.254.218.218 
 

 
 

 
5. Select the model set up by the course instructor (below is an example from another 

model), and you will get information about the project: 
 



 

Novapoint 21 Base course                July 2018 151 

 
 
 

6. Click the tab Users:  
 

 
 

 
7. Click the Close button. All users that has been added can download the workset from 

the project.  
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Download a workset from the server project 
 

1. When you have been given access to a server project (Quadri) by getting a username 
and password, you can download a workset. 

 
On the start page of Novapoint Base, click Join a Project: 
 

 
 

 
2. Here you will find a list of servers you can work with, with which you have set up a link 

to. Click the + character in front of Course – 195.254.218.218. 
 

 
 

3. You will be asked to log in. 
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4. You will see the models that you have access to. 
 

 
 
Click the + in from of the project name you want to work on: 
 
 

5. You will see a list of projects under this model: 
 

 
 
In the dialog you will see the area of interest for the project on the map, as well as the 
properties and coordinate system below the map. 
 
Click the project name, and you will get the dialog for downloading the workset. 
 
 

6. If you have download the project before you will get this dialog: 
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7. Click  and the workset is downloaded. It can take some time, depending 
on the size of the model. 
 

 
 
 

8. When the workset is finished downloading, remember to save. 
 

 
 
It is recommended to save frequently. 
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Status on tasks in the workset 
 
In the explorer, the different tasks have icons that shows the status. A task can have the 
following status:  
 
 

1. Read only in the workset. The task is not reserved by another user: 
 

  (grey line) 
 

 
2. Read only in the workset. The task is reserved by another user: 

 

   (grey line with a lock) 
 
 

3. Task reserved by you, and can be edited in this workset:  
 

  (green line) 
 
 

4. Task reserved by you which is changed in your workset, but not shared to the server:  
 

  (Blue line with an exclamation mark) 
 
 

5. A new task created by you, but not shared to the server: 
 

  (green plus) 
 
 
The following picture shows an example with line task L 20000. It is not reserved in this 
workset, and you can’t edit it: 
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By hovering the mouse over a task you will see if the task is reserved, and by which user. You 
will also see which user lastly made changes to the task: 
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Receive and Share new tasks 
 
You can create new tasks in Novapoint Base and share these to the server. By clicking Receive, 
you will update your model with tasks and features made by others. 
 
These two functions you will find under the tab Home > Quadri.   
 

 
 
 
 
Receive 
 

1. If you want to receive tasks made and shared by other users, click Receive: 
 

 
 
If you have not loged in, you will get the log in dialog. Log in. 
 
After logging in, there will first be a check towards changes made in the server project. 
 

 
 
When the check is finished, the dialog below will come up. It shows a list of changes, 
who made them, and when. 
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Example: Show all Shared Changes: 
 

 
 
Example: Shared Changes on a specified date: 
 

 
 
 

2. Click Receive All Updates. The dialog below will come up. It will show time remaining 
for receiving changes: 
 

 



 

Novapoint 21 Base course                July 2018 159 

 
When the receiving is finished, the dialog below comes up. It shows all changes. Click 
Close: 
 

 
 

 
3. By hovering the mouse over a task you will see if the task is reserved, and by which 

user. 
 
Example under shows a change made by another user: 
 

 

 
 
 
 

4. Save your workset: 
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Share 
 

1. If you want to share tasks with the other users, click Share: 
 

 
 
The tool will change: 
 

 
 

 

2.  Click    and the dialog for description will come up:  
 

 
 
 

3. Give a description to the other users of what you have done, and what you are about 
to share. Click Share. 

  
4. The tasks will now be shared to the server. The icon next to the task will be updated to 

the right statys, e.g. green plus or blue line with lock will change to green line. This 
means that the tasks are shared to the server, but are still reserved in your workset. 
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Release 
 

1. After you have shared the changes you have made, you should now release tasks if 
you are done working on them, to give other users the oppurtunity to work on the 
tasks. 

 
Click a task which is reserved by you, right click it, and click Release: 
 
 

 
 
The release progress bar will come up: 
 

 
 
It is not possible to release a task without it being shared first. 
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Reserve 
 

1. If you want to edit a task, you have to reserve it first. 
 

Click a task, right click it, and click Reserve: 
 

 
 
The reserve progress bar will come up: 
 

 
 
If there are changes on the server that have to be merged into your workset, you will 
get the dialog below. The Receiving process will be initiated. 
 

2. Save you workset:    
 

 
  



 

Novapoint 21 Base course                July 2018 163 

Continue working in a workset 
 
Once you have downloaded a workset, you should continue working on this (not download 
new worksets.) You open a workset by clicking the down arrow next to the open icon, and 
Open Workset: 
 

 
 
Then you open the project from the list: 
 

 
 
After you have opened the project, you should Refresh reservation status: 
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Another way to of opening an existing workset is from the Start Page: 
 

 
 
When you continue working on a previous project, you will get the option on either continue 
working on the workset from last time, or to create a new one (usually selecting to continue). 
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Deleting a workset 
 
When deleting a workset, it is important that you not only delete files with Windows Explorer. 
The reason being that if a user deletes a workset and have forgotten to release some tasks, 
they will be locked on the server (an administrator user can go in and clean up the server.) 
 
To delete a workset, right click your workset in the explorer and click Disconnect Workset. 
 
NB! If you have something in the workset that is not shared to the server and you want to 
keep it, you must first Share before disconnecting the workset. 
 

 
 
Click Yes. 
 

 
 
Click Yes. 
 

 
 
NB! All changes done in this workset after the last share will be lost! 
You should never edit your local workset in Windows Explorer. It will result in that you will 
no longer be able to Receive or Share it.  
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USER NOTES 
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